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1 Vorwort zur Nutzung von Salome Meca

Zu Anfang möchten wir erklären, dass sich dieses Manual nicht als Kompendium versteht. Viel
mehr  möchten  wir  das  Werk  immer  wieder  aktualisieren  und  erweitern.  Daher  bitten  wir  um
Nachfragen  bzgl.  der  hier  dargestellten  Themen  und  auch  um Verbesserungsvorschläge,  damit
dieses Manual sich stetig weiterentwickelt.  Im Laufe der Zeit soll so ein umfangreiches Manual
entstehen, welches all die vielzähligen Möglichkeiten von Salome Meca darstellt und so von jedem
genutzt werden kann, um eventuelle Probleme in den Simulationen zu beheben. Dies genügt in
dieser frühen Version aber als Erklärung und nun möchten wir kurz wichtige Eigenschaften von
Salome Meca erklären:

Salome Meca ist ein grafisches Interface für das FEM-Tool namens CodeAster. Daher erscheinen
manche Wege anfangs  umständlich,  ergeben jedoch Sinn,  wenn der  generelle  Weg  erst  einmal
verstanden wurde. Alles was im Modul namens AsterStudy eingestellt wird, dient einzig dazu, dass
im  Hintergrund  ein  Command-file  geschrieben  wird,  wodurch  CodeAster  die  FEM-Analyse
durchführen kann. Dieser Command-file kann auch separat geöffnet, gelesen und geändert werden
(Siehe Kap 5). 

Daher  werden  die  meisten  CodeAster  Beispiele  als  Textdatei  im  Internet  angegeben,  da  sie
ausschließlich den Inhalt des Command-files enthalten. Mit einiger Eingewöhnung kann dieser file
aber problemfrei gelesen und nach den eigenen Wünschen angepasst werden. Es gibt zwei kleinere
Komplikationen, welche im Umgang mit Salome Meca stets zu beachten sind. 

1: Salome Meca ist eine einheitenlose FEM-Software. Dies bedeutet für den Nutzer, dass er stets
eine konsistente Wahl der Zahlen treffen muss, wenn er Daten eingibt. Dies bedeutet, dass bei der
Verwendung von

Metern als  Längeneinheit,  das E-Modul in Pa angegeben werden muss. Die resultierende
Spannung wird in Pa ausgegeben.
Millimetern  als  Längeneinheit,  das  E-Modul  in  MPa  angegeben  werden  muss.  Die
resultierende Spannung wird in MPa ausgegeben.

Die Kraft muss unabhängig von der gewählten Längeneinheit stets in Newton angegeben werden. 

2: Salome Meca/CodeAster ist eine Software, welche von französischen Entwicklern erstellt wurde,
wodurch noch viele Wörter in Salome Meca französisch sind und der Inhalt des Command-files
nahezu  ausschließlich  in  französischer  Sprache  ist.  Die  Wörter  und  Abkürzungen,  welche  am
meisten verwendet werden sind in der unten stehenden Tabelle jedoch schon einmal in deutsche
Sprache übersetzt. 

CARA →  caractéristique physique → die phys. Eigenschaft
MAIL → le maillage → die Vernetzung (Mesh)
POU → la poutre → der Balken
CHAR → la charge → die Last
AFFE → l'affectation → die Zuordnung
CHAM → le champ → das Feld
mater → le matériau → das Material
BC → die Randbedingung
Liaision → die Verbindung
encastre → eingebaut (fixiert)
tout → ganz (komplett)



2 Einführung

Die  FEM-Simulation  ist  ein  numerisches  Verfahren  zur  Berechnung  von  Lösungen  bestimmter
physikalischer Disziplinen. Dabei wird ein CAD-Bauteil idealisiert, diskretisiert und anschließend
werden die Gleichungssysteme (meist DGLs), welche das System aus Bauteil und Problemstellung
beschreiben, gelöst. Dies wird genutzt, wenn die zu lösenden Gleichungssysteme zu komplex oder
zu zahlreich werden um sie von Hand zu lösen. Ein weiterer Grund für die Anwendung der FEM-
Simulation  ist  der  Prototypenbau  bzw.  dessen  Optimierung.  Früher  wurden  im  Fahrzeugbau
Prototypen gebaut und getestet,  wodurch man erkennen konnte, wo Schwachstellen im Konzept
waren oder wo man eventuell das Design zu optimieren war. Heutzutage kann all dies von einem
FEM-Programm übernommen werden.  Erst  am Ende  der  Optimierung muss  dann ein  Prototyp
gebaut werden um die errechneten Lösungen zu validieren.  Dass Nutzen einer FEM-Simualtion
kann dementsprechend viel Zeit und auch Geld sparen. Der generelle Weg einer FEM-Analyse sieht
wie folgt aus:

Reales Bauteil → Vereinfachung des Bauteil durch Idealisierung und Diskretisierung
→ Festlegen der Randbedingungen (z.B. Lager und Kräfte) → Aufstellen und Lösen der DGLs
→ Gewinn der gesuchten Erkenntnisse

Inzwischen  gibt  es  zahlreiche  Branchen,  welche  die  FEM-Simulation  nutzen,  wie  z.B.  Die
Automobilindustrie, die Luft- und Raumfahrt, die Medizintechnik und die Grundlagenforschung.
Auch wenn in diesem Manual  ausschließlich mechanische Probleme simuliert  werden,  sind die
Bereiche  der  FEM  deutlich  vielzähliger  und  Simulationen  werden  neben  der  Statik  auch  für
Fluiddynamik, Magnetismus, Thermostatik und -dynamik etc. genutzt. 

Dabei erfolgt die Analyse für den Nutzer in drei Schritten:

1. Schritt „Preprozessor“: Das Erstellen eines Bauteils mittels CAD-Software und das Diskretisieren
dieses Bauteils in kleine Segmente, dem sogenannten Mesh.

2. Schritt „Solver“: nach Erstellung des Meshs und der Festlegung der Randbedingungen löst der
Rechner die DGLs.

3. Schritt „Postprozessor“: Die Ergebnisse werden im Postprozessor – im Rahmen des Manuals
„ParaVis“ - angezeigt. 



3 Genereller Prozessablauf

Dieses Manual befasst sich mit dem Prozess der FEM-Analyse und wird nicht auf die Konstruktion
eines  Modells  eingehen.  Die  Beschreibung  des  Prozesses  beginnt  also  mit  dem Vernetzen  des
Modells (Mesh-Modul), gefolgt von der Festlegung der Studienparameter (AsterStudy-Modul) und
endet mit dem Anzeigen der Ergebnisse mittels ParaVis-Modul. Bei der Bedienung der einzelnen
Module werden häufig Funktionen genutzt, welche in tieferen Instanzen von Reitern zu finden sind.
Um den gewählten Weg zu zeigen, wird dieser in eckigen Klammern gesetzt. Beispielhaft bedeutet
also 

[New Entity → Basic → 2D Sketch]

die im Bild gezeigte Auswahl.

Als erster Schritt wird das  Mesh-Modul genutzt um das vorher erstellte geometrische Modell zu
vernetzen. Dies bedeutet, dass ein Netz (das Mesh) beliebig fein um das Modell gespannt wird, da
die FEM-Analyse mit diesem Mesh rechnet. Es ist also essentiell das Mesh zu erstellen. Im Laufe
dieses Prozessschrittes werden sogenannte Mesh-Gruppen erstellt, welche separat anwählbare Teile
des  Gesamtnetzes sind und gebraucht  werden um sie als  Lasten oder  Lager  zu definieren.  Mit
diesen Meshgruppen und der Definition von Materialeigenschaften können dann die Rechnungen
durchgeführt werden, sobald eingestellt wurde, welche Art der FEM-Analyse gewünscht ist. Wie
auf der vorigen Seite angegeben, wird dieses Manual einzig Beispiele für mechanische Probleme
zeigen und andere Disziplinen der Physik nicht berücksichtigen. 

Sobald der Solver die DGLs. gelöst hat, können diese dann im ParaVis-Modul geöffnet werden.
Dort können mit wenigen Klicks die Spannungen, Verformungen etc. farblich dargestellt und eine
quantitative Aussage über diese Eigenschaften getroffen werden. 

Abbildung 1: Beispielhafte Auswahl eines Arbeitspunktes zu Erklärung der 
oben gezeigten Schreibweise



4 Prozessbeispiel 1D-Biegebalken

Der eindimensionale Biegebalken dient als einfaches Beispiel zur Erlangung eines grundlegenden
Verständnisses,  da  es  ohne  komplexe  Geometrie  auskommt  und  somit  die  Bedienung  und  das
allgemeine Vorgehen bei Salome Meca 8 gut erklärt. 

Als Erstes wird das Mesh-Modul geöffnet, da der fertig erstellte Biegebalken (in diesem Beispiel
mit einer Länge von 500 mm) vernetzt werden muss. Dazu wird ein neues Mesh mittels

[Mesh → create Mesh]

erzeugt werden. Im nun öffnenden Fenster namens „create Mesh“(siehe Bild) können die Parameter
für die Einstellung des Meshs getroffen werden. Zu Anfang wird der –im Geometry Modul erstellte-

Biegebalken  als  Geometrie  ausgewählt,  woraufhin
alle Reiter bis auf  1D und 0D ausgegraut werden, da
der  Balken  nur  eindimensional  ist.  Es  stehen
unterschiedliche  Algorithmen  zur  Verfügung,  von
welchen „Wire Discretisation“ gewählt wird um den
Balken in Abschnitte zu unterteilen. Darauf folgend
muss  noch  eine  Hypothese  zur  Diskretisierung
gewählt  werden.  Hierfür  bietet  sich  „Number  of
Segments“ an, um festzulegen, wie viele Abschnitte
der  Balken  haben  soll.  Die  Anzahl  der  Segmente
wird auf 10 festgelegt, womit jedes Segment 50 mm
lang  ist.  Sobald  auf  „Apply  and  Close“  gedrückt
wird, ist die Einstellung für das Mesh abgeschlossen.
Dadurch  erscheint  im  Objekt-Browser  ein  neuer
Eintrag  namens  Mesh,welche  als  Unterpunkte  die
Hypothese,  den  Algorithmus  und  das  eigentliche
Mesh hat. Bevor das Mesh genutzt werden kann,

muss  es  jedoch  noch  berechnet  werden.  Dafür  wird  der  Eintrag  „Mesh_1“  mit  der  rechten
Maustaste angeklickt und der Punkt „compute“ gewählt. Dadurch wird das Mesh berechnet und es
wird eine Übersicht angezeigt, wie viele Knoten, Kanten, Flächen etc. erzeugt wurden. In diesem
Beispiel kann nachgelesen werden, dass insgesamt zehn Edges (Kanten; also Segmente) und elf
Nodes (Knotenpunkte) erstellt wurden. Damit ist die Diskretisierung des Modells abgeschlossen.
Als  nächster  Punkt  müssen Gruppen von Meshs („Mesh Groups“)  erstellt  werden,  damit  diese
später genutzt werden können um auf sie Kräfte aufzubringen oder sie als Lager zu verwenden. 

Zur Erstellung einer Mesh Group wählt man 

[Mesh → Create Group]

woraufhin sich ein neues Fenster öffnet, welche auf der folgenden Seite zu sehen ist.

Abbildung 2: Arbeitsfenster des "create 
Mesh" Menüs



Im oberen Teil wird das gewählte Mesh angezeigt,
darunter kann man die Dimension der Mesh Group
wählen. Node wird als Elementtyp genutzt und die
Gruppe in  „Lager“ um genannt,  da diese Gruppe
später  für  die  Fixierung  des  Bauteils  genutzt
werden soll. Der Group type bleibt unverändert und
als  Content  wird  „enable  manual  edition“
angeklickt.  Daraufhin  wird  im  Mesh  Modul  der
linke  Knoten  angewählt  (befindet  sich  im
Koordinatenursprung)  und  auf  „Add“  geklickt.
Dadurch  erscheint  der  knoten  1  in  der  „Element
IDs“ Liste, woraufhin man auf Apply klicken kann
um die  erste  Mesh  Group  zu  erstellen.  Dasselbe
Vorgehen wird genutzt um die Last zu definieren.
Dafür benennt man die Gruppe in „Last“ um, wählt
den  Knoten  ganz  rechts  und bestätigt  mit  Apply.
Der Knoten sollte die ID 2 haben. Zum Schluss der
Gruppenerstellung wird noch eine Gruppe namens
„komplett“  erstellt.  Diese  hat  als  Elementtyp
jedoch „Edge“ und die Auswahl der Elemente lässt
sich vereinfachen, indem als Content „Select All“ gewählt wird. Diese „komplett“-Gruppe wird für
die  spätere  FEM-Analyse  benötigt.  Nachdem  das  Fenster  geschlossen  wird,  können  die  neu
erstellten Gruppen im Objektbrowser unter dem Punkt Mesh_1 erkannt werden. Damit sind die
Arbeiten im Mesh-Modul abgeschlossen und das Modul „Aster-Study“ kann geöffnet werden. 

In diesem Modul werden die Parameter über die im Bild unter 1 dargestellten Reiter ausgewählt
und die Einstellung im Bereich 2 vorgenommen. In diesem Modul können alle gewählten Werte
stets unten links im Informationsfenster nachgelesen werden. 

Damit die Reiter nicht mehr ausgegraut sind,  muss erst  als  eine neue Prüfung eröffnet werden,
indem auf Case_1 rechtsgeklickt wird und „Add Stage“ gewählt wird. Diese neue „Stage“ kann nun
mit Parametern gefüllt werden um die gewünschte Art von FEM-Analyse durchzuführen. Generell
lassen sich die Reiter von links nach rechts „abarbeiten“, wodurch sichergestellt wird, dass alles
Notwendige für die Analyse definiert wird. Dementsprechend wird als erstes 

[Mesh → Read a Mesh]

gewählt um das erstellte Mesh in das AsterStudy-Modul zu laden. Für die Mesh file location wird
„Mesh_1“ gewählt und das Mesh file format als „Med“ definiert. 

Abbildung 3: Arbeitsfenster des "create 
group" Menüs

Abbildung 4: Arbeitsoberfläche des "Aster-Study" Moduls. Punkt 1 zeigt die Reiter der einzelnen zu
bearbeitenden Unterpunkte. 2 zeigt das Fenster um die einzelnen Unterpunkte zu bearbeiten. 



Damit ist der Reiter „Mesh“ abgearbeitet und als nächstes wird 

[Model Definition → Assign finite element]

gewählt.

Hierbei  wird  nun  die  Art  der  Prüfung  definiert
werden.  Es  wird  „finite  element  assignment“
angeklickt  und  ein  neues  Item  gewählt.  Dadurch
springt  das  Menü  in  ein  neues  Untermenü,  wo
„everywhere“  angeklickt  werden  muss  und  als
Phänomen  wird  „Mechanic“  gewählt  wodurch
entschieden ist, dass die folgende Prüfung sich mit
mechanischen  Problemen  beschäftigen  wird.  Bei
Modelisation wird ein neues  item erstellt  und aus
der Liste „POU_D_E“ gewählt. Dieser Name steht
dafür, dass es sich um einen Euler-Balken handelt
(französisch  poutre=  Balken),  mit  speziellen
Annahmen,  welche  hier  nicht  weiter  besprochen
werden.  Damit  ist  die  Einstellung  für  das  „finite
element assignment“ beendet und es kann

[Model Definition → AFFE_CARA_ELEM]

geklickt werden um den Querschnitt zu definieren.
Dies  ist  nur  bei  diesem  Beispiel  notwendig  und
kann  bei  dreidimensionalen  Modellen  außer  Acht
gelassen  werden.  Im  Menü  wird  POUTRE
angeklickt und beim item wird als Section „cercle“
gewählt und bestätigt. Diese Auswahl bestimmt den
Querschnitt  als  Kreis,  da  cercle  im französischen
Kreis  bedeutet.  Darauf  folgend  muss  „Group  of
elements“ ausgewählt werden und als Gruppe wählt
 man „komplett“ („komplett“ ist die vorher erstellte Mesh Group). Dieser Schritt ist nötig um den
kompletten Balken mit kreisrunder Geometrie zu versehen. CARA (CARA=Eigenschaft) wird auf
R (Radius) und Value auf 10 mm gestellt, was bedeutet, dass Eigenschaft [0] den Radius beschreibt
und Value [0] den quantitativen Wert dafür enthält.

Als nächster Punkt wird

[Material → Define a material]

gewählt  um ein  Material  zu  erstellen,  welches  verwendet  werden  soll.  Unter  Name  wird  das
Material mit „Stahl“ bezeichnet und der Haken bei „linear isotropic“ gesetzt wird. Nach Anklicken
von edit,  öffnet dich ein neues Menü in dem bei Young's Module (also dem E-Modul) 210000
eingegeben wird und die Poisson's ratio (Poisson-Zahl) als 0.3 definiert  wird. Durch Bestätigen
dieser Eingaben ist auch dieser Punkt abgeschlossen. Nun muss dem Modell das erstellte Material
zugewiesen werden. Dazu wird 

[Material → Assign a material]

gewählt und „Model“ angeklickt, damit das geometrisch erstellte Modell ein Material zugewiesen

Abbildung 5: zu treffende EInstellung der 
Elementeigenschaften im 
Bearbeitungsfenster



bekommt. Ein neues Item wird bei „Material assignment“ erstellt, indem „everywhere“ angeklickt
wird  und bei  Material  das  Item [0]  als  „Stahl“  definiert  wird.  Somit  ist  der  Reiter  „Material“
abgeschlossen  und  in  diesem Beispiel  muss  der  Reiter  „Functions  and  Lists“  nicht  bearbeitet
werden. 

Als nächster Reiter wird „BC and Load“ genutzt, indem als erstes

[BC and Load → Assign mechanical load]

gewählt  wird.  Mit  diesem Menüpunkt  können sowohl  Lasten  als  auch Lager  definiert  werden.
Daher wird der Name im Menü zu „Fixpunkt“ umbenannt. Als Punkt wird Enforce DOF angewählt
und ein neues Item erstellt. In diesem Menü wählt man oben bei Group of Node „Lager“ aus und
unten klickt man LIASON → ENCASTRE an. Damit wird der gewählte Punkt in jeder Richtung
fixiert sein.Zur Erstellung der Kraft wird wieder

[BC and Load → Assign mechanical load]

gewählt,  der  Name  in  „Kraft“  geändert  und  der  Haken  bei  FORCE_NODALE  gesetzt.  Bei
Erstellung des Items wird nun bei Group of Node „Last“ gewählt und FZ mit -100 definiert, damit
die Kraft von 100 N nach unten gerichtet ist. Der nächste zu behandelnde Reiter ist „Analysis“.
Dazu wird 

[Analysis → Static mechanical analysis]

gewählt,  Material  field  und Structural  element  characteristic  angeklickt  und als  Load  die  eben
erstellten „Fixpunkt“ und „Kraft“ angewählt.

Als  letzter  Reiter  wird  in  diesem
Beispiel  noch  „output“  bearbeitet
werden. Zunächst wird 

[Output → Set output results]

angeklickt.  Dann  muss  bei  „Result
file location“ der Speicherort, sowie
der Dateiname eingegeben
werden.  Dabei  ist  zu  beachten,  dass  das  Format
„Name.resu.med“  sein  sollte,  damit  ParaVis  später  die
Ergebnisse einlesen kann. Im Bild oben ist das Format zu
erkennen. Nach Eingabe wird Format als Med eingestellt
und ein neues Item bei Results erstellt.
Im  neuen  Menüfenster  wird  Result  angeklickt  und
„reslin(MECA_STATIQUE)“  ausgewählt.  Nach
Bestätigung  der  Menüs  ist  die  Arbeit  im  AsterStudy-
Modul beendet.

Nun  muss  die  Simulation  gestartet  werden.,  Dafür
wird  von  der  Case  View  in  die  History  View
gewechselt,  welche  im  Bild  rechts,  oben  links  zu
sehen  ist.  In  der  History  View  wird  Case_1
angeklickt, Stage_1 aktiviert, der Haken bei Reusable
gedrückt gelassen und schlussendlich ganz unten auf 

Abbildung 6: Beispielhafter Name der zu speichernden 
Datei. 

Abbildung 7: Vollständig ausgefüllter 
Baum des Case View zur Erstellung 
des Lastenbeispiels



Run gedrückt. Nach nochmaliger Bestätigung, dass
die  Simulation  gestartet  werden  soll,  wird  die
Analyse  durchgeführt,  welche  abgeschlossen  ist,
sobald  im  rechten  Fenster  RunCase_1  grün
leuchtet. Danach wird der Reiter „Data Files“ im
Case View geöffnet (siehe Bild rechts). Dort kann
nun auf die resu.med Datei rechtsgeklickt werden
um die Ergebnisse in ParaVis anzeigen zu lassen,
wie im Bild unten gezeigt.

Das ParaVis-Modul ist ähnlich aufgebaut, wie die anderen Module auch. Rechts ist die grafische
Darstellung der  Geometrie  zu  sehen und auf  der  linken Seite  sind unterschiedliche Menüs.  Im
obigen Pipeline Browser sind die durchgeführten Analysen sichtbar, wie in Abbildung 9 dargestellt.

In  diesem Beispiel  beschränkt  sich die  Auswahl  einzig
auf den MEDReader1. Über dem Browser ist rechts eine
Dropdown-Liste  erkennbar,  welche  das  Modell  nach
bestimmten Gesichtspunkten einfärbt. Standardmäßig ist
das  Modell  weiß,  es  kann  jedoch  die  Verformung  des
Biegebalkens  farbig  dargestellt  werden,  indem  in  der
Dropdown-Liste  „reslin_DEPL“  gewählt  wird.  Des
Weiteren kann die Verformung auch grafisch dargestellt

werden,  indem  in  den  Properties  „generateVectors“  aktiviert  wird  und  anschließend  dies
anschließend mit Apply bestätigt wird. Dadurch entsteht in der Dropdown-Liste ein neuer Eintrag
namens „reslin_DEPL_Vector“. Durch Erstellung eines Filters im  Reiter 

[Filters → Common → Warp by Vector]

kann ein neuer Eintrag im Pieline-Browser erstellt werden, welcher die grafische Verformung des
Biegebalkens darstellt.

Im unteren Bild ist die grafische Darstellung der Verformung zu sehen, sowie eine Legende mit dem
maximalen Wert.

Wenn man die Verformung eines Biegebalkens in Abhängigkeit der Länge, Kraft, Querschnitt und
E-Modul errechnet, so werden die 2,526 mm Verschiebung bestätigt. 

Abbildung 8: Auswahl, damit die errechneten
Ergebnisse in ParaVis dargestellt werden.

Abbildung 10: Erzeugtes grafisches Ergebnis der Biegebalken-Analyse. Die Färbung gibt die 
Verformung gemäß der Legende an

Abbildung 9: Pipeline Browser zur 
Auswahl der durchgeführten Analysen



5 Der Command file

Wie  in  Kapitel  2  beschrieben,  ist
Salome  Meca  nur  ein  grafisches
Interface  für  die  textbasierte
Software  namens  CodeAster.  Daher
schreibt  Salome  Meca  alle  Befehle,
welche  ihm  erteilt  werden  in  die
Command  Datei.  Diese  Datei  lässt
sich  separat  öffnen  und  bearbeiten,
wodurch die Simulation den eigenen
Wünschen  angepasst  werden  kann,
ohne Salome Meca zu benutzen. 

Um die Datei öfnen zu können, muss
sie  vorher  aus  dem  Salome  Meca
Projekt exportiert werden. Dazu wird
im  AsterStudy-Modul  auf  die
gewünschte  Stage  rechtsgeklickt,
welche die zu verändernde Studie hat
und  dann  „Export  Command  File“
ausgewählt  (siehe  Bild  rechts).
Dadurch kann die gesamte Command
Datei  gespeichert  und  separat
geöffnet werden. 

Beispielhaft wird hier die Command Datei aus dem Beispiel des Kapitels 4 geöffnet, da das Beispiel
eine vergleichsweise leichte Command Datei darstellt.

Auf der folgenden Seite ist der Inhalt der Command Datei gezeigt, welche mittels eines Texteditors
geöffnet  wurde.   Im  Folgenden  werden  die  einzelnen  Einträge  der  Datei  besprochen  um das
Grundverständnis für CodeAster weiter zu vertiefen.

Abbildung 11: Durch Auswahl von Stage 1 und 
anschließendem Anklicken des "Export Command File" 
Befehls erhält man den Command-File der durchgeführten 
Biegebalken-Analyse



Zeile 1: DEBUT() markiert den Beginn der Datei
Zeile 3: „mesh“ wird als der Name des eingelesenen Meshs definiert,  welches im Format  

„med“ gespeichert wurde.
Zeilen 5-8: Das Analysemodell wird definiert. Die Zuordnung des Meshs wird als Euler-Balken 

(POU_D_E) und  mechanisches Modell definiert. Als Mesh wird das Netz namens 
„mesh“ (Zeile 3) verwendet.

Zeilen 10-15: Die Eigenschaften der Elemente wird der Definition „elemprop“ zugeordnet. Das  
Modell „model“ (Zeilen 5-8) wird genutzt. Der Balken hat einen Durchmesser von 
10, besitzt einen kreisrunden Querschnitt und wird aus der Mesh-Gruppe „komplett“ 
gebildet.

Zeile 17: „Stahl“ wird als verfügbares Material definiert. Die Poisson-Zahl beträgt 0,3 und das 
E-Modul erhält den Wert 210000.

Zeilen 19-21: Das Material „Stahl“ (Zeile 17) wird dem Mesh „mesh“ und dem Modell „model“ 
(Zeilen 5-8)vollständig (tout=oui) zugeordnet.

Zeilen 23-25: Die Randbedingung „Fixpunkt“ wird definiert.  Sie besteht aus der Knotengruppe  
„links“ und ist in allen Dimensionen festgesetzt (encastre).

Abbildung 12: Inhalt der exportierten Command Datei der Biegebalken-Analyse aus Kapitel 4



Zeilen27-29: Die Randbedingung „Last“ wird definiert. Sie besteht aus der Knotengruppe „rechts“
und ist übt eine Kraft von -100 in Z-Richtung aus.

Zeilen 31-36: Das Ergebnis wird festgelegt. Die Eigenschaften der zu analysierenden Elemente ist 
„elemprop“ (Zeilen 10-15), das zu nutzende Material ist „fieldmat“ (Zeilen 19-21), 
die zu nutzenden Randbedingungen sind „Last“ und „Fixpunkt“ (Zeilen 23-29) und 
das Modell ist „model“ (Zeilen 5-8).

Zeile 38: Das Resultat wird im Format med gespeichert und die Daten, welche analysiert 
werden sollen, sind im Bereich „reslin“ zu finden (Zeilen 31-36).

Zeile 40: FIN() beendet die CoadeAster Command Datei.

Die Angaben „Unite“ geben die Dateiendungen an, welchen CodeAster beim Öffnen der Dateien
erwartet.  Generell sind diese Werte nicht zu verändern und werden standardmäßig von Salome-
Meca ohne jegliche Befehlseingabe automatisch erstellt.


